
Fluency 
Overview Guide



Comprehension
& Vocabulary

Phonological
Awareness

Communication

FluencyLanguage
Concepts

Phonics

Waterford Early Learning’s

Six Instructional 
Strands for Literacy



Research-Based Principles    2

Research-Based Principles
Hasbrouck and Glaser (2012) define reading fluency as “reasonably 
accurate reading at an appropriate rate with suitable prosody 
(expression) that leads to accurate and deep comprehension and 
motivation to read.”

Fluent readers can perceive words in 1/20th of a second and can read 
at a rate of 150–250 words per minute (Kilpatrick, 2015). This level of 
reading fluency is possible only when students have developed a 
large bank of “sight words” (defined here as words that a reader can 
recognize automatically, without the need to decode). 

Words are added to a student’s sight-word bank through the brain’s 
orthographic-mapping process, which draws upon a student’s 
phonological awareness, phonics, and oral language skills to 
permanently bond the spelling, pronunciation, and meaning of a 
word and make it instantly accessible for the reader when that word is 
encountered again. With a growing number of sight words anchored 
in the brain’s reading network, the cognitive load that was previously 
dedicated to decoding is decreased. This allows the student to use 
that cognitive space to focus on meaning as they read, which supports 
reading comprehension (National Reading Panel, 2000).

A word-mapping approach to classroom instruction aligns well with 
the brain’s orthographic-mapping process and supports the growth of 
students’ sight-word banks.

A growing body of research (see Share, 1999; Share, 2004; Kilpatrick, 
2015) shows that when typically developing readers become reasonably 
proficient with the word-mapping process, they begin to self-teach 
as they read. Through repeated exposure to a given word, mapping 
occurs naturally. Orthographic knowledge related to that word is 
then available for future encounters with the word and similar words, 
decreasing the student’s reliance on decoding (Castles et al., 2018). 
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Because multiple exposures to words build fluency, engaging students 
in repeated reading of appropriately challenging texts is an effective 
way to support the brain’s orthographic-mapping process and foster 
the development of a large bank of sight words. 

Word mapping is an effective instructional approach for both regularly 
and irregularly spelled words. With repeated exposure, new words 
are added to a student’s sight-word bank. For irregularly spelled 
words, a greater number of exposures may be needed for the brain 
to make mapping “adjustments” to account for irregularities in 
letter-sound correspondences.

Fluency Skills Development

Less Complex More Complex

Beginning Developing Advanced

	⦁ Letter recognition 
automaticity 

	⦁ Letter-sound automaticity

	⦁ Read-aloud experiences 
that model fluent reading

	⦁ Build sight-word bank through word 
mapping practice

	⦁ Read increasingly complex texts with accuracy 
and expression at an appropriate rate

Parallel focus on comprehension
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Waterford Early Learning 
Instruction

  → Fluency Skills Taught and Scope & Sequence

View example fluency activities from Waterford Early Learning’s 
adaptive learning path → here.

Explicit, systematic instruction within Waterford Early Learning’s 
adaptive learning path supports the development of the phonological 
awareness, letter recognition, and letter-sound correspondence skills 
that are foundational building blocks for reading fluency. With these 
skills in place, students begin to build word-level fluency through 
extensive word mapping and word-building practice.

Waterford Early Learning’s adaptive learning path includes hundreds 
of experiences with connected text. Decodable texts (Readable books) 
as well narrative and informational read-along books provide fluency 
practice at all stages of reading development. The book experiences 
included embedded support for decoding and comprehension. Many 
also include narration as a model for fluency. 

1 2 3

Students hear the 
sounds (phonemes) 
and then connect the 
phonemes to the letters 
(graphemes) to map 
CVC words.

Students map words 
by connecting sounds/ 
phonemes—/s/ /a/ /k/— to 
letters/graphemes— 
s-a-ck.

Students use the oa-t 
pattern to map similar 
words such as goat, 
throat, coat, and float.

https://resources.waterford.org/reference-materials/3772/3772.pdf
https://www.youtube.com/playlist?list=PLcOxVO3wRlRSVfomkQHfCQbgSZXqfCi80
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Short passages from Waterford Early Learning’s Readable books are 
featured in fluency activities. These activities provide opportunities 
to practive repeated reading of familiar text that is aligned with 
the phonics instruction students have received. And because 
comprehension is the ultimate goal of reading, many fluency activities 
in the digitial learning path are followed by a check for understanding. 

Reading with expression contributes to reading comprehension. 
To read with appropriate expression, students must think about 
the events of the story and attend to punctuation. Waterford Early 
Learning’s explicit instruction for fluency draws upon text from 
the Readable books series and builds students’ ability to read at an 
appropriate rate, with accuracy and expression.
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Resources
Resources to support fluency skills 
development in the classroom and at 
home include the following:

Letter Recognition and Letter-
Sound Automaticity

  → In Resources & Activities,

	⦁ SEARCH “letter cards.”

	⦁ FILTER for Subject & Strand>Literacy>Phonics, and SEARCH 
“letter recognition.”

  → Letter-Sound Songs

  → Letter-Sounds Connections 1: Video

  → Letter-Sounds Connections 2: Video

  → Letter-Sounds Connections 3: Video

Word-Level Fluency
  → Word Mapping

  → Word Mapping Student Template

  → Six Syllable Types

  → In Resources & Activities, 

	⦁ FILTER for Resource Type>WEL Activity and SEARCH “fluency.”

Modeled Fluency
  → Traditional Tales: Narrated in English and Spanish

  → In Resources & Activities, go to

	⦁ Collections>Books: Traditional Tales
	⦁ Collections>Books: Read-Along
	⦁ Collections>Books: Informational Texts
	⦁ Collections>Books: Biographies

A Waterford account is required 
to access program hyperlinks 
(displayed in orange). If you do 
not have an account, you can 
request a demo account here.

https://teacher.waterford.org/activities
https://teacher.waterford.org/activities?search=letter%20cards
https://teacher.waterford.org/activities?query=subject%3DLiteracy%257CPhonics&search=letter%20recognition
https://www.youtube.com/watch?v=tJajKkMXtBc&list=PLcOxVO3wRlRRHnWU8IlC_OWuJdsgHgvEz
https://resources.waterford.org/videos/4649/4649.mp4
https://resources.waterford.org/videos/4650/4650.mp4
https://resources.waterford.org/videos/4651/4651.mp4
https://resources.waterford.org/teacher-resources/4588/4588.pdf
https://resources.waterford.org/family-resources/2965/2965.pdf
https://resources.waterford.org/teacher-resources/4592/4592.pdf
https://teacher.waterford.org/activities
https://teacher.waterford.org/activities?query=resourceType%3DWEL%2520Activity&search=fluency
https://www.youtube.com/playlist?list=PLcOxVO3wRlRSijjxEOWbie8gZXqHJqz6c
https://teacher.waterford.org/activities
https://teacher.waterford.org/activities?query=collections%3DBooks%253A%2520Traditional%2520Tales
https://teacher.waterford.org/activities?query=collections%3DBooks%253A%2520Read-Along
https://teacher.waterford.org/activities?query=collections%3DBooks%253A%2520Informational%2520Texts
https://teacher.waterford.org/activities?query=collections%3DBooks%253A%2520Biographies
https://www.waterford.org/reading-academy/#request-demo


Resources    7

Repeated Reading 
  → Beginning Readers and Decodable Books

  → In Resources & Activities, go to 

	⦁ Collections>Books: Readables.

  → In Resources & Activities,

	⦁ FILTER for Resource Type>WEL Activity and Subject & 
Strand>Fluency.

Fluency Observation 
  → Fluency Check Sheets

Parallel Focus on Comprehension
  → In Resources & Activities, go to 

	⦁ Collections>Reading Extension Activities to find classroom 
comprehension resources related to Waterford Early Learning 
and popular trade books.

Playlists
  → In Resources & Activities,

	⦁ FILTER for View>All Playlists and Subject & 
Strand>Literacy>Fluency.

Family Resources
  → Family Fact Sheet: Fluency
  → Hoja de datos familiars—Fluidez

  → Family Video: Fluency
  → Video de elemento de instrucción de la fluidez

https://resources.waterford.org/reference-materials/3975/3975.pdf
https://teacher.waterford.org/activities
https://teacher.waterford.org/activities?query=collections%3DBooks%253A%2520Readables
https://teacher.waterford.org/activities
https://teacher.waterford.org/activities?query=resourceType%3DWEL%2520Activity%26subject%3DLiteracy%257CFluency
https://teacher.waterford.org/activities?query=resourceType%3DWEL%2520Activity%26subject%3DLiteracy%257CFluency
https://resources.waterford.org/teacher-resources/2076/2076.pdf
https://teacher.waterford.org/activities
https://teacher.waterford.org/activities?query=collections%3DReading%2520Extension%2520Activities
https://teacher.waterford.org/activities
https://teacher.waterford.org/activities/playlists?query=subject%3DLiteracy%257CFluency
https://teacher.waterford.org/activities/playlists?query=subject%3DLiteracy%257CFluency
https://resources.waterford.org/family-resources/4740/4740.pdf
https://resources.waterford.org/family-resources/4739/4739.pdf
https://resources.waterford.org/videos/1016/1016.mp4
https://resources.waterford.org/videos/1966/1966.mp4
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Instructional Routines
The following instructional routines can serve as frameworks for 
whole-class, small-group, and individual instruction. These routines 
leverage the elements of effective instruction that are built into the 
adaptive learning path for Waterford Early Learning.

Modeled Fluency
Use this routine to model fluent reading for students during read-
aloud experiences with narrative and informational text.

1.	 Choose a book that is related to topics and/or other texts in your 
classroom curriculum. This will help support the added objective 
of building students’ vocabulary and background knowledge to 
support reading comprehension.

2.	Before Reading, set a purpose that relates to comprehension. For 
example, before reading The Gingerbread Man, ask students to 
think about the pattern in the story as you read. Let students know 
that you will be modeling what fluent reading sounds like and 
reminding them that reading fluently does not equal reading fast.

3.	During Reading

	⦁ Demonstrate how punctuation—including end punctuation, 
commas, and quotation marks—can guide the expression you use. 

	⦁ Model how to read longer sentences with expressive phrasing.

	⦁ Use facial expressions, slower/faster pacing, and louder/softer 
tones to reflect the characters’ feelings and convey the events 
of the story.

	⦁ Invite students to join in at key moments in the story so that 
they can practice the use of appropriate expression.

	⦁ Keep comprehension at the center of the experience by 
pausing to ask questions and lead discussion that focuses 
on meaning.

https://resources.waterford.org/books-prek-2-/1260/1260.pdf
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4.	After Reading

	⦁ Maintain a focus on meaning through follow-up discussion 
and activities. → These classroom activities relate to The 
Gingerbread Man. Activities for learning at home can also be 
shared in English and Spanish.

	⦁ Draw attention to word patterns in the book that align with 
phonics concepts students are learning. For example, after 
reading The Gingerbread Man, you might talk about the 
pattern in the words man, ran, and can. Follow up with word 
mapping practice to foster the development of students’ sight 
word banks.

Note: Fluency can be modeled in any language! For example, you can 
share El hombre de jengibre with students and families as appropriate.

Repeated Reading
Use this routine to provide students with structured reading 
experiences that foster the development of fluency.

1.	 Choose a decodable book that aligns with the phonics instruction 
students have received to ensure that they have the necessary skills 
to successfully navigate the text.

2.	Before Reading
	⦁ Review the word patterns and Power Words students will 

encounter in the book, with a clear focus on the letter-sound 
correspondences within words. As needed, use the instructional 
routine for word mapping outlined → here.

	⦁ Model fluent reading of part of the text, reminding students 
that reading fluently means reading smoothly, accurately, and 
with expression. Reading fluently does not equal reading fast 
but at an appropriate steady rate. As you model, slow down to 
use a rate that approximates the rate at which students will 
likely read the text.

https://resources.waterford.org/class-activities/4874/4874.pdf
https://resources.waterford.org/family-resources/4877/4877.pdf
https://resources.waterford.org/family-resources/4878/4878.pdf
https://resources.waterford.org/books-prek-2-/1264/1264.pdf
https://resources.waterford.org/reference-materials/5284/5284.pdf
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	⦁ Set a purpose that relates to comprehension. For example, 
before students read Dev and His New Pet, ask students to 
think about what kind of pet Dev will have and what he will do 
with his pet.

3.	During Reading
	⦁ Provide guidance and support as needed, centering the focus 

on the letter-sound correspondences within words and drawing 
upon the instructional routine for decoding outlined → here.

	⦁ Direct students to reread as necessary to read phrases and 
sentences with fluency and to maintain their understanding of 
the text.

4.	After Reading
	⦁ Review the text to reinforce fluency practice. For example, write 

a list of words from the text that include the short e sound.

	⦁ Maintain a focus on meaning by facilitating a discussion about 
the story. What kind of pet does Dev have? What do Dev and 
his pet do together? What problem happens in the story?

5.	Engage students in multiple readings of the text to support the 
development of reading fluency.

https://resources.waterford.org/books-prek-2-/3272/3272.pdf
https://resources.waterford.org/reference-materials/5284/5284.pdf
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Corrective Feedback
Corrective feedback has been shown to be a particularly powerful form of 
feedback (Hattie & Jaeger, 1998). It has a substantial effect size, meaning 
it can significantly improve learning outcomes. Within Waterford Early 
Learning’s adaptive learning path, corrective feedback helps students build 
new understandings through productive struggle. 

As you engage students in the instructional routines outlined above, 
provide corrective feedback that

	⦁ is immediate and timely;

	⦁ is targeted and specific;

	⦁ is asset-based and encouraging;

	⦁ provides additional information, as applicable (e.g., how the letter 
sounds align with or differ from a student’s home language);

	⦁ approaches the task in a new way, as applicable (e.g., presenting 
an additive blending approach as a follow-up to a whole-word 
blending approach);

	⦁ is shared through multiple modalities (e.g., visual and 
auditory); and

	⦁ does not simply provide the correct answer, but instead guides 
students to confirm or self-correct their thinking to arrive at the 
correct answer.
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